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Welcome to WindO/I-NV2!

WindO/I-NV2 is IDEC's screen creation software for the HG1F, HG2F, HG2S, HG3F and HG4F
operator interfaces (touch screen displays.) WindO/I-NV2 is used to create projects or
programs that layout display screens for the O/Is. Using this window based program, any of
IDEC's touch screens can display information from a PLC, process status, or can be used to
input data with virtual switches or keypads to make changes to a process.

WindO/I-NV2 is easy and intuitive. Many of the processes are self-explanatory and guide you
from step-to-step as you configure the O/I. The help menus are simple, straightforward, and
are a good resource for getting additional information.

Creating colorful displays has never been easier. With Symbol Factory you have 5000 built in

images for your disposal. You can also import almost any Bitmap or JPEG file into your project.

WindO/I-NV2 highlights:
Built-in Serial and Network Protocols
Pass-thru function
Download, upload & view OI via Ethernet
Debug function
Over 5000 built-in bitmap library
Supports Windows Fonts
Supports Multiple Languages
Supports Scripting
Intuitive Drag & Drop Functionality
Flexible Screen Display for Efficient Editing
Workspace — easy to manage projects & screens



Notes - WindO/I-NV2

There are the following notes when you use WindO/I-NV2, please following the instruction.

Supported MICRO/I
WindO/I-NV2 supports the HG2G/3G/4G, HG1F/2F/2S/3F/4F.

Text and Fonts

)

2)
3)

In a character input, when there are number restrictions of characters, such as a
"Registration Text" or a "Message Display", a carriage return is equivalent to two
characters.

The recommendation font of WindO/I-NV2 is "Small font" of a Windows system.

The font, line and the resized Picture displayed on WindO/I-NV2 may differ from a display
with the MICRO/I, please make sure in the MICRO/I.

Screen display/ Print

)
2)
3)

4
3)

Depending on the hardware configuration of the personal computer currently used, a
picture may be confused while in use. Then please turn off a hardware accelerator.

If garbled characters are shown in printing, please set "Printing Font" again.

When the project which the file size is big is printed with RTF file, a message regarding
clipboard is sometimes opened. Please separate Print Range then print them to solve this
problem.

Picture file size in Picture Manager may be displayed as OKB.

Screen images in Screen List may not be displayed properly. (Only upper half of screen
image is displayed.)

Edit

)

2)

3)

4

3)

WindO/I-NV2 does not have the limitation of number of editing screens which can be
opened at the same time. The limitation depends on the RAM in PC.

When Open/Close Project command is repeated to the project, a message regarding
insufficient memory is sometimes opened. Please exit WindO/I-NV2 once then re-launch it
to solve this problem. This condition depends on the environment of PC such as the
number of the running application software at the same time.

We do not guarantee to launch 2 WindO/I-NV2 at the same time though you can edit while

referring the opening project on the other.

There are the following notes when you use NV2 Metafile.

- When the NV2 Metafile consisted with outline which the line width is or bigger than 2
dot is set to Button/ Pilot Lamp/ Multi-State Lamp/ Picture Display, the outline is
not updated even if the images such as OFF/ON are changed or the image is
disappeared. To solve this note, set the outline which the line width is 1 to NV2 Metafile.

- When Paint object is used in the NV2 Metafile, the image is sometimes changed after
resizing Picture or part object which NV2 Meta file is used.

Export of the library screen is not supported in the case of the following O/I Type.



- HG3G/HG4G, HG3G/4G(Multimedia), HG2G-5FT

6) In Tag Editor, blank cell can not be copied & pasted.

7) In Data Log Setting, a selected device address may be deleted if more than one channels
are selected. In this case, configure the device address for each channel.

8) Host Communication Error appears if invalid tag name is set. If the invalid tag name is
directly entered, it may not be checked. This is only applicable for Allen-Bradley Ethernet/IP
(Logix Native Tag) driver.

9) Host Communication Error appears if the data type of registered tag is changed. If data
type of the registered tag needs to be changed, remove the tag and then set it again. This
is only applicable for Allen-Bradley Ethernet/IP (Logix Native Tag) driver.

10) Script data may be deleted when Host I/F driver is changed if the script has errors. In this
case, remove the error from the script and then, change Host I/F driver.

I'1) In Message Display and Bar Chart, the tag name which contains lower case can not be
assigned in the settings of General tab. Use the tag name which consists of upper case.

Communication

I) When the cable remove or turn off MICRO/I while communicating with the MICRO/I,
WindO/I-NV2 will not work.

2) The screen monitor can not monitor the value of the Host device set for write only. Use
Custom Monitor or Batch Monitor if you want to monitor the device.

3) Do not write 16bit data or bit data to the 32bit device in Emerson ROC Protocol.

4) Do not send more than one command at the same time if Ethernet is selected as User
Communication Interface.

5) Host Communication Error appears if "Modified data only" is selected when downloading
the project. When downloading the project data, select "All" in Download dialog box. This is
only applicable for Allen-Bradley Ethernet/IP (Logix Native Tag) driver.

6) When transferring files to and from the Memory Card in O/I Link Slave, it may fail if
WindO/I-NV2 and O/I Link Master are connected via USB cable. If file transfer is failed,
connect the WindO/I-NV2 and O/I Link Master with Ethernet cable.

Touch Panel

When more than one button is pressed at the same time, due to the detection characteristics
of an analogue type touch panel for HG2G/3G/4G, HG1F/EX4R, only the gravity center of the
pressed area is sensed and the unit assumes that only one button is pressed. Thus, when more
than one button is pressed simultaneously, the resulting operation is not guaranteed.

Multimedia Function
I) Movie files that can use Fast Forward and Rewind are as following restrictions.

- If the playback time is 10 minutes or less, the file must have at least one or more
I-frame every 2 seconds

- If the playback time is 10 minutes or more, the file must have at least one or more
I-frame every 5 seconds

2) A popup screen consisting of the video display will remain if the popup screen is moved
while video is displaying images or while a movie file is playing.

3) If the SD memory card is not recognized then the movie files may not play immediately
after starting running the MICRO/I. In such cases, perform playback after LSM21 (ON



while accessing the memory card) is turned ON.

Parts
1) In Meter object, "Show Ticks" function is not available if FO001, FO101or FO201(No Flange)
is selected as part object image.

Back Up Project

When WindO/I-NV2 crashes while editing project, the recovered project might be corrupted. In
Ver.4.95, WindO/I-NV2 can restore the original project file which is one before editing. If you
want to use the original project from [Project Recovery] dialog, select the project name which
has [_backup] instead of selecting one you were editing.



WindO/I-NV2 Ver.5.13

<Application Software>
The following functions have been introduced.

» The shortcut function created in the Windows OS start menu during WindO/I-NV2
installation has been moved to the WindO/I-NV2 help menu.

<Downloader>
The following functions have been introduced.

» The shortcut function created in the Windows OS start menu during Downloader
installation has been moved to the Downloader help menu.

<Pass-Through Tool>
The following functions have been introduced.

» The shortcut function created in the Windows OS start menu during Pass-Through Tool
installation has been moved to the Pass-Through Tool menu.



WindO/I-NV2 Ver.5.12

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

» In "Command Settings" dialog box for user communication setting, an error message is

displayed even though value of "Transmission Wait" setting is less than value of "Period"
setting for "Fixed Period".



WindO/I-NV2 Ver.5.09

<Application Software>

Bugs Fixed
The following problems have been fixed:

» 2 byte character can be set as a password on "Security" dialog box without an error
message. Therefore, when the password is required, the password cannot be unlocked
because the text box for password does not allow you to input 2 byte character.

» If you operate on the "Screen Diagram" when the "View" tab is displayed, WindO/I-NV2
may crash.



WindO/I-NV2 Ver.5.08

<Application Software>
Bugs Fixed
The following problems have been fixed:

» If the focus is moved to radio buttons on the dialog box, the selected setting may be
changed.



WindO/I-NV2 Ver.5.07

<Application Software>
The following functions have been introduced.

» Checking for updates function of Automation Organizer has supported Microsoft .NET
Framework 4. Install of Microsoft .NET Framework 2.0 to 3.5 is not needed by this support.

Bugs Fixed
The following problems have been fixed:

» When creating a new project, if "NOHOST" is selected as "Host I/F Driver", and then "Host"
is selected as "Target" in "Device Address Settings" dialog box which is opened from
"Project Settings" dialog box, WindO/I-NV2 crashes.

<Downloader>

Bugs Fixed
The following problems have been fixed:

» When downloading files to the memory card by using command line and the password is
included in it, Downloader freezes.



WindO/I-NV2 Ver.5.06

<Application Software>

Bugs Fixed
The following problems have been fixed:

» There is a wrong description in the explanation for STRCUT on Script Editor dialog.

» When there are errors in scripts, displayed line numbers on Script Compilation Output of
Script Editor dialog may be incorrect.

» In Script, when more than two "return" statements exist, the second or later "return"
statements don't work.

» In Script, when "if" statement exists in "default" of "switch" statement, the script does not
work properly.



WindO/I-NV2 Ver.5.05

<Application Software>

Bugs Fixed
The following problems have been fixed:
» When "Dot" is selected as "Bit Number Symbol" in WindO/I-NV Options and one of the
following Host I/F drivers is used, bit devices cannot be used.
- PLC-5 (Half Duplex)
- SLC 500 (Half Duplex)
- MicroLogix/SLC500 (Full Duplex)
- Ethernet/IP
- Logix DF1 (Full Duplex)



WindO/I-NV2 Ver.5.04

<Runtime System Software>
The following functions have been introduced.

» The judgment of device range error is improved. This is applicable to HG4G/HG3G and
HG2G-5F.



WindO/I-NV2 Ver.5.02

<Application Software>
The following functions have been introduced.
» Windows 10 is supported.

Bugs Fixed
The following problems have been fixed:

» When "Change Device Settings" is executed and "Coordinates" value is not a product of 20,
device addresses cannot be imported. This is applicable to HG4G/HG3G, HG2G-5F/-55/-S
and HG1F.

» Importing and exporting device addresses by "Change Device Settings" are not supported
in some settings.
» When MITSUBISHI is selected as the Host I/F driver, the following problems occur:

- Host I/F Driver shown in Target Info is incorrect.
- The project cannot be opened after the upload.

<Downloader>
The following functions have been introduced.
» Windows 10 is supported.

Bugs Fixed
The following problems have been fixed:

» When Downloader is uninstalled from the PC and Downloader for a different language is
installed, Downloader cannot be launched.

» When MITSUBISHI is selected as the Host I/F driver, the following problems occur:
- Host I/F Driver shown in Target Info is incorrect.

<Pass-Through Tool>
The following functions have been introduced.
» Windows 10 is supported.

Bugs Fixed
The following problems have been fixed:

» When Pass-Through Tool is uninstalled from the PC and Pass-Through Tool for a different
language is installed, Pass-Through Tool cannot be launched.



WindO/I-NV2 Ver.5.01

<Application Software>
Bugs Fixed
The following problems have been fixed:

» When "Alarm List Display" or "Alarm Log Display" is used in the project and it is opened,
WindO/I-NV2 crashes. This is applicable to HG2G-55/-S.



WindO/I-NV2 Ver.4.99

<Runtime System Software>
The following functions have been introduced.

» The error information string is added in the message which is displayed when a device
range error occurs. This is applicable to HG4G/HG3G and HG2G-5F.

XXXXX_YYYYyyyyy_2Z72727727777
X: MICRO/I system software version, Y: Category, y: Details, Z: Reserved

Category and Details is followings.

B, S Base/Popup screen number (y is the screen and the internal object
number of the error’s occur)

G Global Script(y is script ID)

X User Communication

P Preventive Maintenance Function

L Data Log or Line Chart

R Alarm Log or Recipe

0] Operation Log

Y System Area

Example:43500_B0001_005_01076840E(MICRO/I Version 4.35.00, the base screen number is
1 and the internal object number is 5)

» When "Show script error" in the Project Setting is checked, MICRO/I displays Device range
error. This is applicable to HG4G/HG3G and HG2G-5F.

<Application Software>
The following functions have been introduced.
» The response for operations when "Home" tab is opened is improved.

Bugs Fixed
The following problems have been fixed:

» Created books cannot be deleted in "Picture Manager". This is applicable to HG4G/HG3G
and HG2G-5F.



The details for the selected model are incorrect on "Change O/I Type" dialog.

When the zoom magnification for the screen is changed, the gridlines may not be displayed
properly.

Even when "Log function" is disabled, the settings on "Options" tab may be enabled in
"Data Log Settings" dialog. This is applicable to HG4G/HG3G and HG2G-5F/-5S5/-S.

The icon of HG4G/HG3G is displayed for the listed projects for HG2G-5F on "Project
Recovery" dialog. This is applicable to HG2G-5F.



WindO/I-NV2 Ver.4.98

<Application Software>

The following functions have been introduced.

»

Exporting library screens is supported. This is applicable to HG4G/3G and HG2G-5F.

Bugs Fixed

The following problems have been fixed:

»

In English version, when tag name which contains lower case is set in [Message Display] or
[Bar Chart], lower case changes to upper case. This is applicable to HG4G/3G and
HG2G-5F.

When some channels are selected in [Data Log Settings] and settings are changed by
[Edit...] button, some settings disappear. This is applicable to HG4G/3G and HG2G-5F.

When 256 Color Bitmap or NMF file is set in [Picture Manager], "0" is dislayed as the size of
picture. This is applicable to HG3G and HG2G-5F.

When O/I type is changed in the process of creating a new project, WindO/I-NV2 may
crash.

When [Visible condition] is configured and [Advanced] mode is changed to [Basic] mode in
a part object, the projects cannot be downloaded.

The bottom part of the image is cut off on [Screen List] window.

The overlaying screens of the reused screen are not displayed when [Reuse Screens]
function is used.

In Emerson ROC Protocol driver, when a project is repeatedly saved, WindO/I-NV2 may
crash.

An invalid value can be set in third argument of MEMCPY and MEMCMP in [Script Manager].
A value which is out of range of the selected [Data Type] can be set in [Script Manager].

<Downloader>

The following functions have been introduced.

4

Only pictures which are checked on [Picture Manager] can be downloaded in external
memory.



WindO/I-NV2 Ver.4.95

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4

4

Drawing objects are not displayed correctly when "Coordinates" of "Overlay with Base
Screen" is set any point other than origin(0,0). This is applicable to HG4G/3G and HG2G-5F.
When an image in NMF format including the polygon is used as picture of a button, the
images of the button flickers. This is applicable to HG4G/3G and HG2G-5F.

When SIEMENS S7-1200(Ethernet) driver is selected, incorrect value may be written to
Host device if value is written in more than one Host device at the same time.

When SIEMENS S7-1200(Ethernet) driver is selected, value may be written to incorrect
Host device address if the value is written in more than one Host devices at the same time
by using script function. This happens if the Host devices are not sequential number.

<Application Software>

The following functions have been introduced.

4

When WindO/I-NV2 crashes while editing project, restore the project file which is one
before editing.

Bugs Fixed

The following problems have been fixed:

»

When trigger condition is set in a part objet, device cannot be imported using [Change
Device Settings].

When version of the second decimal place is from 6 to 9, a library screen cannot be
opened.

If Emerson ROC Protocol is selected as Host I/F driver, the Parameters which has
unsupported data type of TIME are shown on [Device Address Settings] dialog.



WindO/I-NV2 Ver.4.93

<Application Software>
The following functions have been introduced.

» Windows 8.1 is supported.
» If Allen-Bradley Ethernet/IP (Logix Native Tag) driver is selected, the performance of

saving project is improved.
Bugs Fixed
The following problems have been fixed:

» If the O/I type is changed from HG4G/3G, HG2G-5F to HG2G-5S/-S and the project
contains Recipe Settings, the following problems occur.

- WindO/I-NV2 crashes.
- Recipe data is corrupted.

» If a tag name is set to a device, the device is not displayed on [Device Address
Settings].This is applicable to HG4G/3G and HG2G-5F.

» Paste function for Tag Name/Comment may not work on Tag Editor.

<Downloader>
The following functions have been introduced.

» User account is supported.
» Windows 8.1 is supported.

<USB Autorun Definition File Creation Tool>
The following functions have been introduced.
» Windows 8.1 is supported.

<Pass-Through Tool>
The following functions have been introduced.
» Windows 8.1 is supported.



WindO/I-NV2 Ver.4.91

<Runtime System Software>
The following functions have been introduced.

» In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, the communication speed is
improved when accessing data type DINT or REAL. This is applicable to HG4G/3G,
HG2G-5F.

Bugs Fixed
The following problems have been fixed:

» In Numerical Input, Numerical Display or Calendar, if [None] is selected as [Image Type], a
part of the drawing remains when the numerical value is changed. This is applicable to
HG4G/3G and HG2G-5F.

» In Script, when you write a value to a host device using SET function, it may not be written
to the host device.

<Application Software>
The following functions have been introduced.

» In Modbus RTU Master, Modbus RTU Slave, and Modbus ASCII Master driver, the default
settings in [Interface Settings] are changed. Modbus RTU Slave is only supported by
HG4G/3G and HG2G-5F.

» In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, the performance is improved in the
following operations.

- Open project
- Open base screen or popup screen

» In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, the following functions are changed
in Tag Editor.

- Delete tag function is added.
- Forbid changing the parameters except tag name of tag which is used in the project.
» Cut, Copy, and Paste functions between Tag Editor and Microsoft Excel are supported.

Bugs Fixed
The following problems have been fixed:

» Pictures may not be imported when screen is imported.

» When 2 byte character is used in a script, WindO/I-NV2 may crash when Script Editor is
closed.

» In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, the following problems may occur.
- A bit of word tag which is set as [Report Device] in [Data Log Settings] is deleted.
- The tags which are set in the following settings are deleted.



* [Report Device] in [Calendar]
* [Use Reference Device] in [Destination Device] in [Word Button]
* [Use Reference Device] in [Destination Device] in [Word Write Command]

- If a project is created by an older version, the tags which are used in the project may be
changed other tags when the project is opened by newer version.

- If a project is created by an older version and bit of word tags are used in the project,
host communication error occurs after downloading the project by newer version.

» When multiple tag names or comments including blank cells are pasted on Tag Editor,
those blank cells are removed.



WindO/I-NV2 Ver.4.88

<Runtime System Software>
The following functions have been introduced.

» Lower case characters are supported when "Device" is selected as Receive data in User
Communication Function. This is applicable if "ASCII(HEX) to Binary" is selected as
"Conversion Type" in "Data Settings". This is applicable to HG4G/3G and HG2G-5F/-55/-S.

Bugs Fixed
The following problems have been fixed:

» If MEMCPY function is used in script function and host device is selected as destination
device, scan speed becomes slower. This only happens if "Always Enabled" or "While
satisfying the condition" is selected as "Trigger Type".

» In Data Log function, "Report Device" is not initialized even if the device which is selected
as "Clear Log Data" in "Individual Settings" turns on. This is applicable to HG4G/3G and
HG2G-5F/-5S/-S.

» In Data Log function and Operation Log function, "Monitor % space Used in Data Storage
Area" is not initialized even if log data is cleared. This is applicable to HG4G/3G and
HG2G-5F/-55/-S.

» A part of part object disappears when an adjacent part object is blinked or hided on popup
screen. This is applicable to HG4G/3G and HG2G-5F.

» When "Device" is selected as "Display Points" or "Scroll Size" in Line Chart, and the device
value is grater than 32768, it is handled as minus value. This is applicable to HG4G/3G and
HG2G-5F/-55/-S.

» When "Cursor Display Position" is set in Line Chart, and the device value is grater than
32768, it is handled as minus value. This is applicable to HG4G/3G and HG2G-5F.

<Application Software>
The following functions have been introduced.

» The description for the HG Special Registers (LSD) and the HG Special Relays (LSM) is
added. This is applicable to HG4G/3G and HG2G-5F/-5S/-S.

Bugs Fixed
The following problems have been fixed:

» Some device types are not displayed on Tag Editor.

» In Data Log Settings, the setting value of [Threshold] on [Report when % Space Used has
reached or exceeded Threshold] is not reflected to operation. This is applicable to
HG4G/3G and HG2G-5F/-55/-S.

» If there are any characters except alphanumeric in a script, "Find" function might be failed
in script editor.



In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, WindO/I-NV2 might crash after
opening the device setting dialog repeatedly.

After changing the property of more than one part object which has Windows font setting
at a time, the screen which contains those part objects might not be able to be opened.



WindO/I-NV2 Ver.4.84

<Runtime System Software>

The following functions have been introduced.

»

The maximum number of Text Group is expanded to 32.This is applicable to HG4G/3G and
HG2G-5F/-5S/-S.

Support float32 data type in Recipe Function. This is applicable to HG4G/3G and
HG2G-5F/-5S/-S.

Support Target Setting Function in DM Link Ethernet(UDP). This is applicable to HG4G/3G
and HG2G-5F.

In USB Autorun Function, add an option not to clear keep devices(LK/LKR) in downloading
project file function. This is applicable to HG4G/3G and HG2G-5F.

IP Address, Subnet mask, Default gateway, and IP address of external device can be
changed with Internal MICRO/I Devices. This is applicable to HG4G/3G and
HG2G-5F/-5S/-S.

Improve the response of operation while writing CSV file to the SD Card. This is applicable
to HG4G/3G and HG2G-5F.

Bugs Fixed

The following problems have been fixed:

4

Update the connection diagram for Mitsubishi FX1, FX2 and FX2C. Delete FX-2PIF from the
system configuration.

The popup screens may not be opened and closed if "Use Reference Device" is enabled.
In Emerson ROC protocol, if TLP humber is bigger than 127, Communication Error occurs.
If "Display error message" in "Project Settings" is disabled and PLC is not connected to
MICRO/I, the system screens are closed.

Incorrect color might be displayed on the boundary of different colors in graphic or text.
This is applicable to HG2G-5F.

<Application Software>

The following functions have been introduced.

»
»

New features or improvements are added from the Runtime System Software upgrade.

Change the protocol name from "Modbus RTU" to "Modbus RTU Master" in Sub Host
Communication.

Bugs Fixed

The following problems have been fixed:

»

»

When Bit Button, Word Button or Goto Screen Button is changed to Multi-Button using
"Change Part type", WindO/I-NV2 freezes.

If the station number of host devices in script is 10 or grater than 10, the station number is



changed to different value after uploading the project.

<USB Autorun Definition File Creation Tool>
The following functions have been introduced.

» Add an option not to clear keep devices.



WindO/I-NV2 Ver.4.83

<Runtime System Software>
The following functions have been introduced.

» DM Link Ethernet(UDP) is supported. This is applicable to HG4G/3G and HG2G-5F.
» Improve the read process of TP, TA, CP, CA, RLEN, RPOS. This is applicable to HG4G/3G
and HG2G-5F.

Bugs Fixed
The following problems have been fixed:

» In Calendar object, even if "Alarm" is selected as "Calendar Type", Date and time of
Calendar object appears. This is applicable to HG4G/3G, HG2G-5F.

<Application Software>
The following functions have been introduced.
» In INT, DINT and SINT data type, a bit in word data can be selected.

Bugs Fixed
The following problems have been fixed:
» Base screens and popup screens are not displayed on [Screen List] window when opening

an existing project.

» In a script, a tag name including both a period and a comma is changed to invalid tag name
when opening an existing project.

» In Allen-Bradely Ethernet/IP (Logix Native Tag) driver, Host Communication Error may
occur in the following cases.

- The property dialog box is closed by cancel button after a tag name is entered.

- The property dialog box cannot be closed by OK button because of an incorrect setting
after a tag name is entered.

» When you change Device Type on Tag Editor, Tag Editor might crash.



WindO/I-NV2 Ver.4.82

<Runtime System Software>
The following functions have been introduced.

» Support "Hitachi Industrial Equipment Systems EH(Ethernet)" driver. This is applicable to
HG4G/3G and HG2G-5F/-55/-S.

Bugs Fixed
The following problems have been fixed:

» If "S7-200(PPI)" driver is assigned to COM1 and O/I Link master is assigned to COM2, the
communication speed between the MICRO/I and the PLC is slow.( This issue only happen if

the baud rate of O/I Link is 57600bps or faster.) This is applicable to HG4G/3G and
HG2G-5F.



WindO/I-NV2 Ver.4.81

<Application Software>

Bugs Fixed
The following problems have been fixed:

» In Numerical Input or Character Input, if [While ON] or [While OFF] is selected in [Trigger
Type] of [Input Condition] on [Trigger Condition] tab, [Device] cannot be set.

» In Allen-Bradley Ethernet/IP (Logix Native Tag) driver, if an arrayed tag is selected in any

property, and then it is changed to other tags, MICRO/I may not be able to communicate
the PLC.



WindO/I-NV2 Ver.4.80

<Runtime System Software>

The following functions have been introduced.

»

The number of HG Keep Relays and HG Keep Registers that are transferred to flash
memory using LSM10 have been expanded from 1024 each to the number set with the
data storage area. This is applicable to HG4G/3G and HG2G-5F.

The following settings for Meter can now be individually specified as Value or Device. This
is applicable to HG4G/3G and HG2G-5F/-55/-S.

- Minimum

- Maximum

- Range

Sub folders can be copied by using file copy function. This is applicable to HG4G/3G and
HG2G-5F.

Add LSM52 to detect Remote control operation. This is applicable to HG4G/3G and
HG2G-5F.

All users password can be changed in System menu. This is applicable to HG4G/3G and
HG2G-5F/-55/-S.

Support pass-through function by using WindSRV. This is applicable to HG4G/3G and
HG2G-5F.

Support "Modbus RTU Slave" driver. This is applicable to HG4G/3G and HG2G-5F.

The maximum number of connected PLC for Ethernet communication is expanded to 32
from 16. This is applicable to HG4G/3G and HG2G-5F.

Support STRING device in "MicroLogix/SLC500 (Full Duplex)" and "Ethernet/IP" driver. This
is applicable to HG4G/3G and HG2G-5F/-55/-S.

Support STRING data type in "Ethernet/IP(Native Tag)" driver. This is applicable to
HG4G/3G and HG2G-5F.

Improve the communication speed in "MELSEC-FX(CPU)", "MELSEC-FX2N(CPU)" and
"MELSEC-FX3UC(CPU)" driver. This is applicable to HG4G/3G and HG2G-5F/-5S/-S.
Change the driver name from "SIEMENS S7(Ethernet)" to "S7-1200(Ethernet)". This is
applicable to HG4G/3G and HG2G-5F/-55/-S.

Change the driver name from "MODBUS RTU" to "Modbus RTU Master", Change the driver
name from "MODBUS ASCII" to "Modbus ASCII Master". This is applicable to HG4G/3G and
HG2G-5F/-55/-S.

Improve processing speed. This is applicable to HG4G/3G and HG2G-5F.

Improve the processing speed when Lamp is blinking. This is applicable to HG4G/3G and
HG2G-5F.

Improve the response speed of touch panel. This improvement is active if the HG3G/4G
and HG2G-5FT are the following lot number or newer and WindO/I-NV2 software version is
4.74 or newer.

- HG2G-5FT : 73X23-00004

- HG*G-*JT22TF : 73Y14-00001



- HG*G-*JT22MF : 73919-00055

Lot number is described by the following rule.
- until September 2016
ABCDD-EEEEE
BCDD is manufactured date.
B: Year( 0-6 is assigned to 2010 - 2016)
C: Month( 1-9, X-Z are assigned to January - December)
DD: Day
EEEEE: Serial Number

- October 2016 or later
ABBCDD-EEEEE
BBCDD is manufactured date.
BB: Year( 16-99 is assigned to 2016 - 2099)
C: Month( 1-9, X-Z are assigned to January - December)
DD: Day
EEEEE: Serial Number

Bugs Fixed

The following problems have been fixed:

»

If "Update the display by ENT button" is enabled and "Display Digits" is more than 48 digits,
"Processing Error" is displayed when "ENT" key is pressed in keypad.

If user communication setting is corresponded to the following conditions, received data
may not be saved to the device.

- There are more than on receive commands which contain the same start delimiter and
end delimiter, and the commands also contain "Device", "Registering
Constant(Character), or "Registering Constant(Hexadecimal)".

- When MICRO/I receives the data, the above commands are active.

If Windows font is set in Message Display and scroll function is enabled, the message can
not be displayed properly.

In numerical display, if blinking is stopped while the number is not displayed, the number
will not be displayed until the number is changed.

In Picture display, the displaying image will remain on the screen if the position or size is
changed while trigger condition is not satisfied.

In the following cases, screen image does not appear unless touch panel is released.
- Turn on the power and then keep pressing the touch panel.
- Change Operation Mode and then keep pressing the touch panel.
This is applicable to the following models.
HG2G-SB22TF, HG2G-SB22VF
HG2G-SS22TF, HG2G-SS22VF
HG2G-SB21TF, HG2G-SB21VF



4

HG2G-SS21TF, HG2G-SS21VF

HG2G-5ST22TF
If battery voltage is low, initial screen does not appear when turn on the power.
This is applicable to the following models

HG2G-SB22TF, HG2G-SB22VF

HG2G-SS22TF, HG2G-SS22VF

HG2G-SB21TF, HG2G-SB21VF

HG2G-SS21TF, HG2G-SS21VF

HG2G-5ST22TF

<Application Software>

The following functions have been introduced.

4
4
4
4

New features or improvements are added from the Runtime System Software upgrade.
Support Windows 8.
Add dedicated password for opening project.

This is applicable to a communication driver, Emerson ROC Protocol. Add a option to input
TLP on "Device Address Settings" dialog box.

Bugs Fixed

The following problems have been fixed:

4

This is applicable to a communication driver, Allen-Bradley Ethernet/IP (Logix Native Tag).
The project saved with the older version of WindO/I-NV2 might not be opened.

This is applicable to a communication driver, Allen-Bradley Ethernet/IP (Logix Native Tag).
If a project is downloaded after editing, a host communication error may occur on the
Touchscreen.

Picture drawing objects and the part objects that image is picture cannot be placed on the
library screen.

Trigger Condition of the part object might not be properly displayed on the edit screen.
When User Communication is selected on Protocoll ~ 3 on the Project Settings dialog box,
WindO/I-NV2 might not allow to configure the Port No. of Target even if it is proper.

After the project is downloaded to the MICRO/I with the Zooming Conversion selected and
Change O/I Type executed, the position of registration text on part objects displayed on
the MICRO/I differs from the position displayed on the WindOI-NV2.

<Downloader>

The following functions have been introduced.

»

Support Windows 8.

<USB Autorun Definition File Creation Tool>

The following functions have been introduced.



» Support Windows 8.



WindO/I-NV2 Ver.4.75

<Application Software>

Bugs Fixed
The following problems have been fixed:
» If Host I/F driver is Allen-Bradley Ethernet/IP (Logix Native Tag), the following problems

might occur.
- WindO/I-NV2 crashes while editing project.
- A host communication error occur on the Touchscreen.

<Downloader>

Bug Fixed
The following problems have been fixed:
» "HG" is displayed in the communication message though Downloader communicates to the
FT1A Touch.



WindO/I-NV2 Ver.4.74

<Runtime System Software>

The following functions have been introduced.

» Toshiba Machine Works, Hitachi and Mitsubishi FREQROL series PLC are supported. This is
applicable to HG4G/3G and HG2G-5F

Bugs Fixed

The following problems have been fixed:

» If BCD8, BIN32(+), BIN32(+/-) or float32 is selected as data type in Numerical Display,
Data Over function does not work. This is applicable to HG2G-5S5/-S.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» If allocating a host device to the following configurations, the part object does not work
according to the device value.
- Line Chart: Minimum, Maximum, Display Point, Scroll Size
- Bar Chart: Origin, Minimum, Maximum



WindO/I-NV2 Ver.4.72, 4.73

What's new in WindO/I-NV2 Version 4.73
<Application Software>

Bugs Fixed

The following problems have been fixed:

» This is applicable to a communication driver, Allen-Bradley Ethernet/IP (Logix Native Tag).

If the name of Logix Native Tag is changed on the Tag Editor and it is allocated to the
trigger condition, the trigger condition might be blank after re-opening the project file.
If "Address with Relative Value" is selected as "Replace Type" and "All" is not selected as
"Search Range", the Replace can not be performed.

When User Communication is selected on Protocoll ~ 3 on the Project Settings dialog box,
the Port No. of MICRO/I and Target can not be same.

If the Condition is "While satisfying the condition" or "Satisfy the condition", the tag name
including the strings "SM", "SD", or "WSM" cannot be configured on the trigger condition.

What's new in WindO/I-NV2 Version 4.72
<Runtime System Software>

The following functions have been introduced.

» "Horizontal(Flip)" is supported as Installation orientation. This is applicable to HG2G-5S/-S.

Bugs Fixed

The following problems have been fixed:

4

If scan speed is low, sound file can not be played sequentially. This is applicable to
HG4G/3G.

When popup screen is closed, sound file playback is stopped. This is applicable to
HG4G/3G.

<Application Software>

The following functions have been introduced.

4

New features and improvements are added from the Runtime System Software upgrade.



WindO/I-NV2 Ver.4.71

<Runtime System Software>

The following functions have been introduced.

» Ethernet communication in SIEMENS S7-1200 is now supported. This is applicable to

HG4G/3G and HG2G-5F/-5S5/-S.

Bugs Fixed

The following problems have been fixed:

4

»

A user that belongs to Operator/Reader group cannot access to the Web Server Function.
This is applicable to HG4G/3G and HG2G-5F.

"Stroke" or "7-Segment" is selected as "Font" and "None" is selected as "Image Type" in
Numerical Input or Numerical Display, they don't display proper image. This is applicable to
HG4G/3G and HG2G-5F.

If text on a lamp is located outside of the screen, the lamp does no update properly. This is
applicable to HG4G/3G and HG2G-5F.

If file copy function is performed from USB Autorun Function, file copy process may be
stopped. This is applicable to HG4G/3G and HG2G-5F.

<Application Software>

The following functions have been introduced.

4

New features and improvements are added from the Runtime System Software upgrade.

Bugs Fixed

The following problems have been fixed:

»

Specific tag name may be judged to be an error in the trigger conditions of the part objects
and Script Editor.

When you use Script Editor to edit scripts, WindO/I-NV2 might crash.
Screen image may not be printed correctly.

Enable "Copy Data Log Data" for Data Log Function, and then specify Device for the end
number of the Target Data. When you download this project, MICRO/I displays "Device
range error".

If a tag name is used in the script, MICRO/I might be reset after downloading the project.

If a picture file is imported to the project file and the extension of picture file is "jpeg", an
error message is displayed after version up conversion when opening a base screen and
popup screen.



WindO/I-NV2 Ver.4.70

<Runtime System Software>

The following functions have been introduced.

»

The following parts can now be displayed without flange and plate. This is applicable to
HG4G/3G and HG2G-5F.

- Numerical Input

- Character Input

- Message Display

- Message Switching Display
- Calendar

For details, refer to the "View Tab" of each parts of the WindO/I-NV2 User's manual
B1119(12).

"float32" has been added as Data Type with the following parts. This is applicable to
HG4G/3G and HG2G-5F.

- Bar Chart
- Pie Chart
- Meter

For details, refer to the "General Tab" of each parts of the WindO/I-NV2 User's manual
B1119(12).

The following functions have been added to CSV output function in Alarm Log function,
Data Log function, and Operation Log function. This is applicable to HG4G/3G and
HG2G-5F.

- Handle a value of device as a string and set it as file name of CSV file

- Add date and time to the file name

- Execute real time output at an arbitrary timing

For details, refer to the "Memory Card Output Tab" of each functions of the WindO/I-NV2
User's manual B1119(12).

When Real Time is selected in Memory Card Output with Alarm Log function, Data Log
function, and Operation Log function, the log data is output as a CSV file before the log
data size exceeds the maximum amount of Data Storage Area. This is applicable to
HG4G/3G and HG2G-5F.

For details, refer to the "Memory Card Output Tab" of each functions of the WindO/I-NV2
User's manual B1119(12).

Added a function to Numerical Input to display the data over maximum and minimum
values. This is applicable to HG4G/3G and HG2G-5F/-55/-S.

For details, refer to Chapter 10 " Methods of using the Numerical Input" on page 10-3 of
the WindO/I-NV2 User's manual B1119(12).

Added a function to Data Log function to delete log data by channel. This is applicable to
HG4G/3G and HG2G-5F/-55/-S.



For details, refer to Chapter 14 "m Clear Log Data" on page 14-18 of the WindO/I-NV2
User's manual B1119(12).

» Script used with Global Script can now be set up to a maximum of 16. This is applicable to
HG4G/3G and HG2G-5F/-55/-S.

For details, refer to Chapter 20 "3.2 Global Script Settings Dialog Box" on page 20-14 of the
WindO/I-NV2 User's manual B1119(12).

» The OFF image in Multi-State Lamp can now be set. This is applicable to HG4G/3G and
HG2G-5F/-5S/-S.
For details, refer to Chapter 9 "State Tab" on page 9-24 of the WindO/I-NV2 User's manual
B1119(12).

» The following settings for Bar Chart can now be individually specified as Value or
Device. This is applicable to HG4G/3G and HG2G-5F/-55/-S.

- Origin
- Minimum
- Maximum

For details, refer to Chapter 11 " Data Format" on page 11-4 of the WindO/I-NV2 User's
manual B1119(12).

» The following settings in Line Chart can now be specified as values of device. This is
applicable to HG4G/3G and HG2G-5F/-55/-S.

Minimum
Maximum

- Display Points
Scroll Size

For details, refer to Chapter 11 "General Tab" on page 11-22 of the WindO/I-NV2 User's
manual B1119(12).

» The size of Password Screen can now be selected. This is applicable to HG4G/3G and
HG2G-5F.

For details, refer to Chapter 4 "m Use Large Password Screen" on page 4-31 of the
WindO/I-NV2 User's manual B1119(12).

» PLC Program Transfer Function now supports Ethernet communication. This is applicable
to HG4G/3G and HG2G-5F.

» IDEC SmartAXIS Pro/Lite is supported. The name of host I/F driver was changed due to the
addition of applicable models.

- 0Old: OpenNet(FC3A),MicroSmart(FC4A/FC5A)

New: OpenNet,MicroSmart,SmartAXIS Pro/Lite(RS232C/485)
- 0Old: Web Server Unit(FC3A/FC4A/FC5A)

New: OpenNet,MicroSmart,SmartAXIS Pro/Lite(Ethernet)

» Computer link communication for MITSUBISHI MELSEC-FX is now supported. This is
applicable to HG4G/3G and HG2G-5F/-55/-S.

» Support "Use function6 instead of function16" function as optional setting if "Modbus/TCP
Client" is selected as Host I/F Driver. This is applicable to HG4G/3G and HG2G-5F/-5S/-S.

Bugs Fixed
The following problems have been fixed:



When Close Popup Screen is set in Goto Screen Command, other parts placed on the
same screen might not be displayed. This is applicable to HG4G/3G and HG2G-5F.

When playing a movie while a sound file is playing, LSD72 (sound ID of sound file during
playback) does not become 0. This is applicable to HG4G/3G.

When SD memory card is inserted in MICRO/I, it may not be possible to download the
project to MICRO/I with the USB cable. This is applicable to HG4G/3G and HG2G-5F.
When a sound file is set for the touch sound, the following problem occurs. This is
applicable to HG4G/3G and HG2G-5F.

- It may not be opened the System Screen while displaying video input.

- Play a movie file and press Stop. When a sound file is next played, playback of the
movie restarts after the sound file finishes playing.

On Numerical Input, an error is not displayed even if a value that exceeds Minimum or

Maximum is entered. This is applicable to HG4G/3G and HG2G-5F/-5S/-S.

With Pen Recorder of Line Chart, when the chart to display is one line, the chart

disappears when updating the display stops. This is applicable to HG4G/3G and

HG2G-5F/-5S/-S.

With Normal or Pen Recorder of Line Chart, the following problems occur. This is

appllcable to HG4G/3G and HG2G-5F/-55/-S.
The oldest data cannot be displayed, even by stopping display updates and scrolling
right

- If grid lines were displayed, the grid lines are deleted when the log data displayed on
the chart is cleared

- If the log data is cleared when the log data is a single point displayed on the chart, the
chart is not updated even when new log data is acquired

With Horizontal Peak or Vertical Peak of Bar Chart, if either values of Minimum and

Maximum are 0, the chart is not displayed correctly.

When displaying 32-bit data using channel 17 through 20 of Line Chart, the chart may not

be correctly displayed. This is applicable to HG4G/3G and HG2G-5F/-55/-S.

When KEYENCE KV-3000/5000 is selected as the host I/F driver, the X, Y, M address

progression differs from the PLC programming software. This is applicable to HG4G/3G and

HG2G-5F/-55/-S.

<Application Software>

The following functions have been introduced.

»

New features or improvements are added from the Runtime System Software upgrade.

Bugs Fixed

The following problems have been fixed:

4

In preview or printing, units set to Numerical Input and Numerical Display may be
displayed extending from part objects. This is applicable to HG4G/3G and HG2G-5F/-5S/-S.

The following error message may be displayed when converting or saving a project.

- Disk Full Error

When specifying the bit of a word device with Batch Monitor, the 16th bit is not displayed.
When downloading a project that uses Script to MICRO/I, the device range error may be



displayed on MICRO/I.
» In the following situations, you may not be able to import tag names and comments with

Tag Editor.
- No space in between device symbols and addresses

- Addresses are zero suppressed



WindO/I-NV2 Ver.4.66

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

» Sound file playback may be late after the trigger is ON. This is applicable to HG4G/3G
Multimedia model.

» If Video Display has displayed the image from the video input, then the value of trigger
devices for two or more sound files change from 0 to 1 at the same time, the

highest-priority sound file is not played back and the second one is played back. This is
applicable to HG4G/3G Multimedia model.

» Using the following drivers, MICRO/I may not display the proper state of Timer(contact)
and Counter(contact). This is applicable to HG4G/3G and HG2G-5F/-55/-S.

-~ MELSEC-FX(CPU)
- MELSEC-FX2N(CPU)
-~ MELSEC-FX3UC(CPU)

» Touch panel might not work while operating the MICRO/I. This is applicable to
HG2G-5ST22VF.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» The project file size might bloat while editing a project, and then it takes much time to
open it.



WindO/I-NV2 Ver.4.65

<Runtime System Software>

The following functions have been introduced.

»

In MELSEC-FX2N (CPU) and MELSEC-FX3UC (CPU) drivers, Higher communication speed
than 9600bps is supported. The maximum communicating speed is depends on the CPU
unit. This is applicable to HG4G/3G and HG2G-5F/-55/-S.

The maximum number of "Read-source Devices" on a Popup Screen is expanded to 256
from 64. This is applicable to HG4G/3G and HG2G-5F/-5S5/-S.

Compatible functions for old products are supported.This function can be configured in
Compatibility tab on Project Settings dialog box.This is applicable to HG4G/3G and
HG2G-5F/-55/-S.(HG1F/2F/3F/4F has already supported)

Bugs Fixed

The following problems have been fixed:

4
4

Sound file cannot be played after Video Input is displayed. This is applicable to HG4G/3G.

If the project file in the MICRO/I is more than 6Mbyte, the project download via Ethernet
may be failed.This is applicable to HG4G/3G and HG2G-5F.

If Host devices are used in both Sound function and the following functions or settings, and
Monitor function is used in WindO/I-NV2, MICRO/I may be reset. This is applicable to
HG4G/3G and HG2G-5F.

- System Area

- Global Script

- Disable Switch setting on the System tab in the Project Settings dialog box
- Settings on the Options tab in the User Accounts dialog box

- Preventive Maintenance

MICRO/I is set as TCP Server using User Communication. If TCP connection is
disconnected by Server (MICRO/I), Client may not be able to connect the Server again.
This is applicable to HG4G/3G and HG2G-5F/-55/-S.

In Operation Log function, logging data may not be saved to the SD memory card even if
the Trigger Device of the Batch is ON. This is applicable to HG4G/3G and HG2G-5F.

<Application Software>

The following functions have been introduced.

»

New features or improvements are added from the Runtime System Software upgrade.

Bugs Fixed

The following problems have been fixed:

»

If size of the script is big, the MICRO/I might be reset after downloading a project.



Property of Go to Screen for Multi-Functions gets an error if X/Y coordinates is not a
multiple of 20. This is applicable to HG4G/3G and HG2G-5F/-5S5/-S.

When a project file for HG2F/3F/4F is converted to HG2G-5FT or HG3G/4G, the MICRO/I
might output CSV files for the logging function as the invalid nhame on Memory Card.

This is applicable to a communication driver, Allen-Bradley Ethernet/IP (Logix Native Tag).
A tag name on part object and settings might be changed to the other unintended tag
name while editing the project.

A script error might be shown on the MICRO/I if selecting Dot (WindLDR Format) as Bit
Number Symbol on WindO/I Options in a project that had been downloaded.



WindO/I-NV2 Ver.4.64

<Runtime System Software>
The following functions have been introduced.

» The maximum number of "Read-source Devices" on a Popup Screen is expanded to 256
from 64. This is applicable to HG4G/3G and HG2G-5F/-55/-S.

<Application Software>
The following functions have been introduced.

» New features or improvements are added from the Runtime System Software upgrade.

Bugs Fixed
The following problems have been fixed:

» This is applicable to a communication driver, Allen-Bradley Ethernet/IP (Logix Native Tag).

If a project is downloaded after editing, a host communication error may occur on the
Touchscreen.



WindO/I-NV2 Ver.4.63

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» If Windows font is used as unit in Numerical Display and Numerical Input, a part of these
frange may be filled with the plate color.This is applicable to HG2G-5S/-S.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» Project Settings dialog box can get an error and cannot be closed if projects saved with
version before 4.44 are opened with Ver.4.62. This is applicable to HG4G/3G and HG2G-5F.

» The Property dialog box of the part objects can get an error and cannot be closed if the
Trigger Condition is enabled and the Trigger Type is "While satisfying the condition" or
"Satisfy the condition". This is applicable to HG4F/3F/2F/2S/1F.



WindO/I-NV2 Ver.4.62

<Runtime System Software>

The following functions have been introduced.

»

Improved the project upload process. WindO/I-NV2 only uploaded the related files from
the Access folder in the SD card when uploading a project file. This is applicable to
HG4G/3G, HG2G-5F.

Retained the text color of a unit when entering a number. This is applicable to HG4G/3G
and HG2G-5F/-55/-S.

Bugs Fixed

The following problems have been fixed:

4

The Alarm function in the Calendar object does work properly. The alarm bit is turned on
and off inconsistently. This is applicable to HG4G/3G, HG2G-5F.

When controlling the LEY devices by using an offset in script or Reference Device, outputs
in the expansion module does not work. This is applicable to HG4G/3G, HG2G-5F.

If Reference Device is used in Numerical Input, Numerical Display or Character Input, the
Visible/Invisible function and object overlap do not work correctly while the Reference
Device value is being changed or while the value is invalid. This is applicable to HG4G/3G,
HG2G-5F.

If Reference Device is used in a Numerical Input or a Numerical Display and the
Visible/Invisible condition is changed, a Device Range Error could occur. This is applicable
to HG4G/3G and HG2G-5F/-5S/-S.

In a Numerical Input and a Character Input, if the number or character is set to be
displayed as an asterisk (*), the number or character is displayed in the Keypad window.
This is applicable to HG4G/3G, HG2G-5F.

In a Numerical Input, if Current Screen is selected as Keypad Type and Always Entry Mode
is enabled, data could not be entered properly if the visible/invisible condition is changed
while entering data. This is applicable to HG4G/3G, HG2G-5F.

A move file is not played automatically when "Use Event Recording" is enabled, even if
"Auto Play" is enabled in the Video Display object. This is applicable to HG4G/3G.
MICRO/I may stop if uploading/downloading data or changing system mode when it starts
playing movie file. This is applicable to HG4G/3G.

When the MICRO/I starts running, movie file may not be played. This is applicable to
HG4G/3G.

If a host device is set to “"Report when Sampling Count has reached or exceeded Threshold”
or “Report when % Space Used has reached or exceeded Threshold” in Data Log settings,
invalid value is written to the device. This is applicable to HG4G/3G and HG2G-5F/-55/-S.
The display size of the movie file may be smaller than the Video Display. This is applicable
to HG4G/3G.

<Application Software>



Bugs Fixed

The following problems have been fixed:

4
4

An NG error can appear if MEMCPY and MEMCMP were used in a script.

If a NMF file is allocated to a state of the Multi-State Lamp, it can become "Unregistered"
after overwriting the same file by importing another NMF file to the Picture Manager.

The Popup Screen No. for the Key Button "Alt" become 1 after closing the Properties dialog
box. This is applicable to HG4G/3G, HG2G-5F and Windows 7 64-bit edition.

Project Settings dialog box can get a "Device empty" error and cannnot be closed. This is
applicable to HG4G/3G and HG2G-5F/-55/-S.

The device count in Tag Editor and Cross Reference for devices being used in a script can
be corrupted when those devices are allocated to Part objects and the other settings dialog
box.

In a Numerical Input and a Numerical Display, the number and the unit are not always
displayed according to the configured font. This is applicable to HG4G/3G and
HG2G-S/-55/-5F.

A "Device Range Error" is sometimes shown on the touchscreen if an internal device is set
in a script in a project that had been uploaded and re-downloaded.

In a Multi-Button, when a script command is executed at the beginning of the Function List
and View Switching Method is set to Device, the image of the switch is not always changed
by the value of the allocated device.

The width and height of a .JPG file is shown as 0*0 after it was imported to the Picture
Manager. This is applicable to HG2G-5S/-S.

When the project name is changed in the Explorer tree, WindO/I-NV2 is sometimes unable
to open the project. This is applicable to HG2G-55/-S.

The Cross Reference dialog box sometimes displays incorrect information for a device
having a hexadecimal address.

If the Host I/F driver is MELSEC-Q/QnA(Ethernet), the displayed device address in Tag
Editor is not correct if the device type is WB, WX or WY.

Part objects are sometimes not displayed on the touchscreen.



WindO/I-NV2 Ver.4.61

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

» In the User Communication function, when either Device, Registering Constant (Character

or Hexadecimal) is contained in a transmission (TXD) command, communication stops and
the MICRO/I resets.

When the Web Server function is used for long periods of time, the web server might no
longer be accessed by clients.

The information displayed under Slave Online Status on the Web Server function's System
Information - System Detailed Information page is not correct.

<Host I/F Driver>

Bugs Fixed

The following problems have been fixed:
» When Omron SYSMAC CS1/CJ Series(Ethernet) is selected, Host Communication Error

appears if Fatal CPU Unit error or Non-fatal CPU Unit error happens in the PLC.

<Application Software>

The following functions have been introduced.

4

This is applicable to a communication driver, Allen Bradley Ethernet/IP (Logix Native Tag).
During a tag database (L5K and CSV file) import, a message has been added to alert a user
if the tag imported is not supported. The customer will have the option to bypass the
repeated message and continue with the download of supported tags only.

Bugs Fixed

The following problems have been fixed:

4

»

All settings disappear when projects saved with Ver. 4.50 or Ver. 4.51 are uploaded with Ver.
4.60. This is applicable to HG4G/3G, HG2G-5F/-55/-S.

This is applicable to a communication driver, Allen Bradley Ethernet/IP (Logix Native Tag).
If a project is downloaded after deleting the parts configured with the host device, a host
communication error may occur on the Touchscreen.

If a project is downloaded with text registered in Text Manager as the Registration Text for
a Multi-State Lamp, it may not be displayed on the MICRO/I. This is applicable to HG4G/3G,
HG2G-5F.

If scripts are configured that use the ASCII2DEC, STRSTR, or STRLEN functions in projects
saved with versions before 4.44, NG may be displayed in Script Manager when those



projects are opened with version 4.50 and later but before Ver. 4.60.

The "Disk is full" error might be displayed if projects saved with versions before 4.44 were
later opened in version 4.50 to 4.60.

If a project created as 1:N Communication under Connection in the host I/F driver settings
is changed to 1:1 Communication, the values of devices configured with a station number
other than 0 can no longer be read or written.

If the O/I type is changed, the Alarm Log Display data becomes invalid, and when this
project is downloaded, the MICRO/I resets. This is applicable to HG4G/3G, HG2G-5F.

If the O/I type is changed to HG4G/3G, HG2G-5F with project data uploaded from
HG1F/2F/2S/3F/4F, the picture data may disappear.



WindO/I-NV2 Ver.4.52, 4.60

What's new in WindO/I-NV2 Version 4.60
<Runtime System Software>

The following functions have been introduced.

4

The IP address for hosts configured in Project Settings and Host I/F Network can now be
modified on the System Menu. This is applicable to HG4G/3G, HG2G-5F/-5S-S. For details,
refer to Chapter 33 "m Host I/F Network" on page 33-13 of the WindO/I-NV2 User's
manual B1119(11).

The user communication send and receive data size has been expanded to 1500 bytes.
This is applicable to HG4G/3G, HG2G-5F/-55/-S. For details, refer to Chapter 3 "e
Transmission Command Settings - Constant" on page 3-10 and Chapter 3 "e Receive
Command Settings - Constant" on page 3-18 of the WindO/I-NV2 User's manual
B1119(11).

5x, 6x, 7x has been added to the text magnification. This is applicable to HG4G/3G,
HG2G-5F/-5S5/-S. For details, refer to the "Magnification" setting of each objects of the
WindO/I-NV2 User's manual B1119(11).

The execution interval for the remote monitor & control has been expanded to a maximum
of 5000 milliseconds. This is applicable to HG4G/3G, HG2G-5F. For details, refer to Chapter
27 "Execution Interval" on page 27-3 of the WindO/I-NV2 User's manual B1119(11).
EX4R is supported.

The FC5A-D12 is now supported with the PLC program transfer function. PLC program
from an SDmemory card or USB flash drive inserted on the touchscreen. This is
applicable to HG4G/3G, HG2G-5F.

The recording functions have been improved. This is applicable to HG4G/3G. For details,

refer to Chapter 22 "e Record tab" on page 22-14 of the WindO/I-NV2 User's manual
B1119(11).

Bugs Fixed

The following problems have been fixed:

4

4

Calendar data may have invalid values when using the remote monitoring and remote
control functions or cyclic scripts. This is applicable to HG4G/3G, HG2G-5F.

If a shadow style is selected as the drawing object , the background color would not display.
This is applicable to HG4G/3G, HG2G-5F.

If a project with Ignore communication errors and continue operation is selected and
downloaded to an O/I link slave, then the Network Offline is displayed and the operation
would not work. This is applicable to HG4G/3G, HG2G-5F/-55/-S.

If a project with Ignore communication errors and continue operation is selected &
downloaded to an O/I link master, the O/I link slave does not recover from Network Offline
if @ host communication error occurs. This is applicable to HG4G/3G, HG2G-5F/-5S/-S.



<Host I/F Driver>
Additional supported Drivers:

» Additional supported Drivers: - YASKAWA MP2000 series (Ethernet)

» Mitsubishi MELSEC-Q/QnA (Ethernet) driver communication speed was improved. This is
applicable to HG4G/3G, HG2G-5F/-55/-S.

» Emerson ROC Protocol driver is not only supported in HG4G/3G and HG2G-5F but also now
in HG2G-55/-S.

<Application Software>
The following functions have been introduced.
» Changed the Save Screen As shortcut to Ctrl+G and assigned the shortcut Ctrl+A to Select
All.

» New features or improvements are added from the Runtime System Software upgrade.

» If Zooming Conversion is selected in the Set Conversion Option, it will automatically
adjust the size of the registered text and coordinates of the screens (i.e. Overlay Screens or
Goto Screen button).

Bugs Fixed
The following problems have been fixed:
» When the host I/F driver is Allen-Bradley Ethernet/IP (Logix Native Tag), WindO/I-NV2 may

be forcibly terminated if tags are used for device addresses.

» When multiple objects are selected and moved, a portion of the objects may not move to
the intended location.

» If the editing window zoom is set to 100% or more when selecting objects, the cursor may
move to an unintended location.

» Create a HG2G-S/-5S project, add a selector switch, and close the screen. When the screen
is opened again, the selector switch is displayed in the location (0,0).

» When opening a project created with an old version, the device information may become
invalid.

» When Picture Manager is opened, the thumbnails may disappear.

What's new in WindO/I-NV2 Version 4.52
<Runtime System Software>
The following functions have been introduced.
» The new password is not requred when transferring a project file from the SD Card/USB
Flash Drive which contains that new password. This is applicable to HG4G/3G, HG2G-5F.
Bugs Fixed
The following problems have been fixed:

» When the Start Time in the Project Settings dialog box is configured, you can not monitor
the MICRO/I properly after clicking the Start Monitor in the Monitors group on the Online



tab. This is applicable to HG4G/3G, HG-S/-5S/-5F.

Remote Control and Monitoring and Port No. settings in the Web Server tab on the Project
Settings dialog box does not work properly. This is applicable to HG4G/3G, HG2G-5F.

In the System Detail Information page on the Web browser, the IP, Netmask, Gateway, and
MAC Addresses are displayed incorrectly. This is applicable to HG4G/3G, HG2G-5F.

The limitation of the read device addresses per Base Screen is 256. If the total read device
addresses on a Base Screen is 256, MICRO/I may display the Device Range Error. This is
applicable to HG2G-S/-5S.

If you repeatedly press the touchscreen for 3 seconds, you can go to the system mode
without the password confirmation even though the touchscreen’s project is password
protected. This is applicable to HG4G/3G, HG2G-5F.



WindO/I-NV2 Ver.4.50, 4.51

What's new in WindO/I-NV2 Version 4.51
<Runtime System Software>

Bugs Fixed
The following problems have been fixed:
» HGAF/EX4R/HG3F/2F/2S/1F may reset if some data is written to Device Address with

Downloader while occurring Host Communication error.

» When the following conditions are satisfied, HG2G-5F and HG4G/3G can't copy Data Log to
Device Address with Data Log function.

- Data Size is 32 bit.

- The number of the logged Data is greater than the setting of "Number of Stored Data
for Data Log per Device".

- The setting of "End No." for "Target Data" is greater than 1.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» Script Manager shows an error when using the bit of word device (E.g. LDR0000-0).

» The tag name for the bit of word device cannot be allocated to the property of parts and
the respective settings.

What's new in WindO/I-NV2 Version 4.50
<Runtime System Software>
The following functions have been introduced.

» Added an advance function to each part with the option to make a part (i.e. button)
operable or non operable and visible or hidden depending on the device value or
condition. This is applicable to HG4G/3G, HG2G-5F.

For details, refer to the “Trigger Condition Tab” of each parts of the WindO/I-NV2 User's
manual B1119(9).

» It is now possible to set the User Communications to the Ethernet Interface. This is
applicable to HG4G/3G, HG2G-5F/-55/-S.

For details, refer to Chapter 4 “3.2 Communication Interface Tab” on page 4-32 of the
WindO/I-NV2 User's manual B1119(9).

» Add the HG Special Relay (LSM24). This bit is ON while writing to the memory card. This is
applicable to HG4G/3G, HG2G-5F.



For details, refer to Chapter 32 “"HG Special Relay (LSM)” on page 32-3 of the WindO/I-NV2
User's manual B1119(9).

Bugs Fixed

The following problems have been fixed:

»

The display update speed becomes slower when the Picture is used on the screen. This is
applicable to HG4G/3G, HG2G-5F.

A specific size of Bitmap is not displayed correctly. This is applicable to HG4G/3G, HG2G-5F.
If used with screens overlapping, "Device range error" may not be displayed.

If the Numerical or Character Input is protected by using the Security Function, you can
still set a value to it. When you moved the focus to it by using the Focus is moved by
ENT button setting, this problem occurs.

Text within the text display area frame on parts in WindO/I-NV2 may not be displayed on
the MICRO/I. This is applicable to HG4G/3G, HG2G-5F.

The message in the Result window at times doesn't appear after copying the files from SD
card to USB flash drive using the Key Button to transfer data.

After copying the files by using the Key Button (labeled Copy Files under Data Transfer) on
either Memory Card or USB flash Drive, the folder icon is displayed without the folder name.
This is applicable to HG4G/3G, HG2G-5F. This is shown on the PC.

Data cannot be uploaded from a Memory Card inserted in the MICRO/I set to O/I Link
Slave. This is applicable to HG4G/3G, HG2G-5F.

The Web Server function cannot be used from Internet Explorer with certain PCs. This is
applicable to HG4G/3G, HG2G-5F.

<Host I/F Driver>

Additional supported Drivers:

4
4
4

FUJI MICREX-SX (Serial)
FUJI MICREX-SX (Ethernet)
Emerson Floboss107

Bugs Fixed

The following problems have been fixed:

»

When the Allen-Bradley PLC-5 or SLC500 is selected for the Expression of Device
Address Format , the Device Monitor cannot be used. This is applicable to HG4G/3G,
HG2G-5F/-5S/-S.

When the 1:N Communication is selected for the Connection with the Modbus/TCP
Client, no recovery when a communication error occurs. This is applicable to HG4G/3G,
HG2G-5F/-5S/-S.

When the 1:N Communication is selected , a value may be read for the Address differs
from the one specified according to the combination of the Station Number and the
Address. This is applicable to the following Host I/F drivers:

- Ethernet/IP

- Logix DF1(Full Duplex)

- DirectLogic(Ethernet)



- KV(Ethernet)
- MELSEC-FX3U(Ethernet)

<Application Software>

The following functions have been introduced.

4
4

New features or improvements are added from the Runtime System Software upgrade.

When creating a new project, the description for the HG Special Registers (LSD) and the
HG Special Relays (LSM) is now registered in the Comment.

Bugs Fixed

The following problems have been fixed:

»

When changing the O/I Type from HG4G/3G to HG2G-5F, the size of the Popup Screen may
not be change correctly.

When opening a project saved with WindO/I-NV2 Ver. 2.50 or earlier in Ver. 4.00 or later
and changing the O/I type from HG4F/3F/2F to HG4G/3G, HG2G-5F, the settings in the
Communication Interface tab may not be converted correctly.

The data under the Data List on Recipe Settings might change values to 0 if the following

actions are taken:

- Change O/I type.

- Upload a project.

- Change the Access to for the Recipe Settings from the Memory Card to Internal
Memory.

The tag name may be judged as an error in the Script Editor.

When a project is opened, the size of the NV2 Metafile (NMF) may change.

A confirmation to save may be displayed when closing the project or when downloading
even when the settings for the project and the screens are unchanged.

If the project is downloaded via Ethernet, the system software download may fail.

If a project for HG4G/3G, HG2G-5F created with WindO/I-NV2 Ver.4.44 is used, a button
may function though the another button is pressed on the screen of MICRO/I.

When uploading the files from the memory card, it may fail.

If Download Project is performed with the option [Modified Data Only] and that operation
is failed by canceling the operation or occurring a communication error, WindO/I-NV2
returns an error when performing the same operation again.



WindO/I-NV2 Ver.4.44

<Runtime System Software>

The following functions have been introduced.

4
4

Added the recording function to the HG3G/4G (video interface equipped models).
Increased the number of blocks for the alarm log setting to a maximum of 128. This is
applicable to HG2G-S/-5S/-5F, HG3G/4G.

Increased the amount of alarm log data storage with the data storage area setting for the
following models.

- HG2G-S/-5S: 5,520 points
- HG2G-5F, HG3G/4G: 11,660 points

HG3G/4G (video interface equipped models): Added a function to adjust the size of a the
movie file display to be 2x the display size so it will display correctly on the Video display.
For instance, if the original display size of the movie file is 100x100 and the size of the
Video display is 400x400, the original movie file display will get adjusted automatically to
200x200.

HG3G/4G (video interface equipped models):The video display can be setup and
connected at anytime. There is no restriction as to when it can be connected.

Added the Slow and the Frame Fwd to the Key Button for the HG3G/4G (video
interface equipped models).

When connect a device to Audio IN/Audio Out interface of the HG3G/4G, use stereo mini
plug. If the device only supports monaural input/output, use a monaural to stereo
converter.

Bugs Fixed

The following problems have been fixed:

»

4

HG3G/4G (models not equipped with the video interface): Sounds with a specific sampling
frequency does not play normally.

When monitoring HG2G-5F, HG3G/4G with the Remote Control function, the O/I Type on
the Target Information page always shows "HG3G-*"

The picture may remain displayed when a movie finishes playing. This is applicable to
HG3G/4G (with video interface only).

The File Screen for movie data may not update. This is applicable to HG3G/4G (with video
interface only).

If the number of alarms that occurred on HG-S/-5S/-5F, HG3G/4G exceeds the Number of
Stored Data for Alarm Log, HG-S/-55/-5F, HG3G/4G may reset or stop displaying data
on the Alarm List Display and Alarm Log Display.

<Host I/F Driver>

Expanded Drivers:



» Extended the range of usable devices for Allen Bradley PLC-5 (Half Duplex). Applicable
for HG2G-S/-5S/-5F and HG3G/4G.

Bugs Fixed

The following problems have been fixed:

» If Ignore communication errors and continue operation is selected as one of the
host I/F drivers below, the value for the host devices may not be set in parts and settings.
- OpenNet(FC3A),MicroSmart(FC4A/FC5A)
- DirectLogic-DL205/405
- Modbus RTU
- MODBUS/TCP Client
- Web Server Unit(FC3A/FC4A/FC5A)
- Ethernet/IP
- MELSEC-Q/QnA(Ethernet)
- Logix DF1(Full Duplex)
- DirectLogic(Ethernet)
- SYSMAC CS1/CJ Ethernet
- Modbus ASCII
- KV(Ethernet)
- Ethernet/IP(Native Tag)

<Application Software>
The following functions have been introduced.
» New features or improvements are added from the Runtime System Software upgrade.

Bugs Fixed
The following problems have been fixed:

» After the project is downloaded to the MICRO/I with the Zooming Conversion selected
and Change O/I Type executed, the size of parts displayed on the MICRO/I differs from
the size displayed on the WindOI-NV2.

» If you change the project file name (for HG2G-S/-5S) in Windows Explorer , the project
can not be downloaded to the touchscreen.

» Upload a project from HG2G-S with project file created in WindOI-NV2 ver. 4.24 or older,
the device settings are completely erased if the project name is changed in the upgrade
version.



WindO/I-NV2 Ver.4.43

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

» When power on the HG2G-5S, it may continue resetting (POWER LED keeps blinking.)

» If a host word device is used in popup screen, and a bit in the word device is changed in
base screen or popup screen, an incorrect value may be written to the word device. (For
HG1F/2F/2S/3F/4F, this problem only happens when the 1:N Communication is selected as
the Connection Type.)

» If host bit device is used in the following functions, the correct device value can not be read.
(For HG1F/2F/2S/3F/4F, this problem only happens when the 1:N Communication is
selected as the Connection Type.)

Alarm

Data Log

Operation Log

Reference Device/Offset Device
Device Monitor function in Web server
Monitor function in WindO/I-NV2

» When the Character Input set as Use as Display for Keypad is used with the HG2G-5F or
HG3G/4G, the characters are not displayed properly.



WindO/I-NV2 Ver.4.42

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» Inthe HG2G-S/-55/-5F and HG3G/4G, if the following host I/F driver is selected in the
project, MICRO/I may stop operation when you cycle power or download/upload a project
file.

- Modicon Modbus RTU

- Modicon Modbus ASCII

- SIEMENS S7 MPI

- SIEMENS S7-200(PPT)
Yasukawa MP920-RTU

» In the HG2G-S/-55/-5F and HG3G/4G, downloading/uploading a project via Ethernet may
be failed, and then you can not download/upload a project. In addition, Remote control
function may not be available.

» In the HG2G-5F and HG3G/4G, MICRO/I may not recognize SD Memory Card.

<Host I/F Driver>

Bugs Fixed
The following problems have been fixed:

» PLC device value may not be updated if using Koyo DirectLogic-DL205/405 driver.

» If Keyence KV-3000/5000 driver is selected in the project, the device value of Link Relay(B),
Work Relay(VB) and Link Resistor(W) may not be referenced to the PLC device value. In
addition, If you write a value to those devices, it may not be written to the PLC.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» Inthe Individual Settings dialog box of the Recipe Settings, on the Data tab, 0 is always
set to the Data column in the Data List if the Memory Card is selected from the Access
to.



WindO/I-NV2 Ver.4.41

<Host I/F Driver>
Additional supported Drivers:

» MITSUBISHI FX3U (Ethernet)
» YOKOGAWA FA-M3 (Ethernet)

Expanded Drivers:
» KEYENCE KV5000 driver: Added more range or device addresses.

Bugs Fixed
The following problems have been fixed:

» Communication error occurs on the HG2G-5F, HG3G/4G if using the Allen-Bradley
Ethernet/IP driver.

» Communication may slow and communication errors may be displayed if using the the
KEYENCE KV(Ethernet) driver with the HG2G-S/-5S.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» If the MICRO/I type in a project that uses a period in the project name anywhere other
than the extension is changed, the location where the MICRO/I internal devices had been
configured becomes blank. For instance, if you make a project named "aaaa.bb" for HG3G,
the project file will be "aaaa.bb.n3g". And you set a "LM 100" (HG Internal Device) to the
Bit Button in this project. After changing the O/I type from HG3G to others, you will see
that the device setting of the Bit Button is deleted.

» You may no longer be able to change the MICRO/I type when opening a project created
with an old version
» Projects cannot be downloaded to the HG2S.

» When multiple pictures are registered in Picture Manager, if one of the pictures is removed
and Picture Manager is reopened, WindO/I-NV2 might crash.



WindO/I-NV2 Ver.4.40

<Runtime System Software>

Improvements

The following functions have been introduced.

4

Supports 5.7" HG2G-5S (256 color TFT LCD Screen) & HG2G-5F (65K color), 8.4" & 10.4"
HG3G w/ Multimedia, and 12.1" HG4G w/ Multimedia.

HG3G/4G Series support multimedia (Video Input). Users are able to display video
images on the touchscreen or play back a movie file stored from the SD memory card.
HG2G-5F, HG3G/4G supports letter size paper when using the print function. (HG2G-5/-55
does not support the letter size paper)

Back Space (BS) key has been added as a key button on a Key Pad when pressing the
Numerical Input. This is only applicable to HG2G-S/-55/-5F, HG3G/4G.

» The User Communication supports full duplex when using HG2G-S.
» Improvements have been made to print from the tray corresponding to the "normal paper"

type in the printer-side settings when using the print function of the HG3G.

Bugs Fixed

The following problems have been fixed:

4

When switching an operating mode with the HG3G (E.g. switch from the System Mode to
the Run Mode), the SD memory card may not be recognized, causing operation to stop.
When using the Remote Control function with the HG3G, the screen will continue to be
displayed on the web browser even if screen display has been turned off.

At power on of the HG3G, the expansion module may not be recognized.

In the HG2G/3G, two overlapped buttons can not be active even if Enable Two-point Push
in Project Settings is enabled. This problem only happens if one of the buttons is located in
a Base Screen and another button is located in the Popup Screen. In addition, Superimpose
is set as Screen Effects in the Popup Screen.

If the DM Link communication is used with the HG3G, the HG3G may stop running when it
sends a reply for a request command and an Event Transmission at the same instant.

<Host I/F Driver>
Additional supported Drivers: (HG3G)

v v v v v Vv

PLC-5 (Half Duplex)

SLC 500 (Half Duplex)

S7-300 3964(R)/RK512

Power Mate-MODEL D/Series 16i
MP920-RTU

MICRO3,MICRO3C



4

Ethernet/IP (Logix Native Tag)

Bugs Fixed

The following problems have been fixed:

»

When selecting MODBUS/TCP Server with the HG2G/3G, the communication is lost if 3 or
more clients are connected. In addition, Communication is lost if cable is connected and
disconnected repeatedly.

When "Koyo DirectLogic-DL205/405" is selected as Host I/F driver, MICRO/I can not
communicate to the PLC.

<Application Software>

Improvements

The following functions have been introduced.

4

Supports 5.7" HG2G-5S (256 color TFT LCD Screen) & HG2G-5F (65K color), 8.4" & 10.4"
HG3G w/ Multimedia, and 12.1" HG4G w/ Multimedia.

New features or improvements are added from the Runtime System Software upgrade.

A function that automatically converts the size of parts and draw objects to match the
screen size when converting the O/I type has been added. You can see this option on the
Set Conversion Option dialog box after selecting Change O/I type.

A function that compares project data and displays setting differences in screen units has
been added. To compare projects, On the Home tab, in the Project group, click Compare.
A function that displays the usage of each script ID in the script manager has been added.
You can see the usage in the Used column in the Script List.

An option to download or not download picture and sound data to the memory card
simultaneously with the download of project data has been added.

When WindO/I-NV2 closes abnormally, it could damage the device address usage
information. A command that rebuilds device address usage information has been added.
Right click the tag editor in the project window and then click Rebuild.

Bugs Fixed

The following problems have been fixed:

4
4

The device usage information will become invalid in Tag Editor or Cross Reference.

When an old version of the project has been opened, the device address that has been set
may disappear.

When using the HG3G and setting it to the USB port in communication settings and if a
project is downloaded while monitoring or while in simulation, the monitor or simulation
mode will not reopen after the download is complete.

<Downloader>

Improvements

The following functions have been introduced.



» Supports 5.7" HG2G-5S (256 color TFT LCD Screen) & HG2G-5F (65K color), 8.4" & 10.4"
HG3G w/ Multimedia, and 12.1" HG4G w/ Multimedia.

» A command line that downloads projects without clearing the HG Keep Register (LKR) and
HG Keep Relay (LK) has been added.

» A command line that downloads projects without downloading picture or sound data to the
memory card has been added.
Bug Fixed
The following problems have been fixed:
» Projects cannot be downloaded to the HG2G-S.

<USB Autorun Definition File Creation Tool>

Added the USB Autorun Definition File Creation Tool, which generates USB Autorun definition
file that are required when using the USB Autorun function. Go to Start menu, click Automation
Organizer, WindO/I-NV2 and then click USB Autorun Definition File Creation Tool.

<Manual>

» Changed the name of Instruction Manual to User's Manual.
» United the Hardware Manual to the User's Manual.



WindO/I-NV2 Ver.4.32

<Runtime System Software>

Bugs Fixed

The following problems have been fixed:

4
4
4

The project will fail to download if more than 4MB of project already existed in the HG3G.
The HG3G can not be controlled by the remote control function when back light is OFF.

If “Disable Switch” option is enabled in Project Settings, the HG3G should not be controlled

by touch panel and remote control function, but it can be controlled from the remote
control function.

The button will not blink if "Device" is selected as the"View Switching Method” and the
“Blink” mode is enabled.



WindO/I-NV2 Ver.4.31

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» When screen switching occurs during communication with the O/I Link, O/I Link
communication errors may occur or the MICRO/I may reset. However, this problem will
occur with the HG1F/2F/3F/4F only when using 1:N communication.

» The following are applicable when using the HG3G Series Touchscreen:

- When parts are placed in layers on the screen, the layered parts will not be properly
displayed.

- The touchscreen will reset depending on the size of the Windows Font.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» After deleting a picture from the Picture Manager that was registered to a project and then
importing a new picture file caused the screen to display an incorrect picture.
» When registering multiple pictures in an HG3G project that was created in Ver. 4.2%,

opening or uploading the project in Ver 4.30 displays an error message that states
"Insufficient memory".



WindO/I-NV2 Ver.4.30

<Runtime System Software>
The following functions have been introduced. (HG3G)

» Remote Monitor and Control function

- Using a web browser on your PC, PDA or smart phone, you can remotely monitor &
control the HG3G Series & PLC for easy maintenance, test, or troubleshoot.

Be able to mount in Portrait (Vertical) mode.

The line chart displays “time” on the x-axis at the cursor position when in manual mode.
Data logs support 32-bit data (BIN 32+, BIN 32+/-, BCD-8, or float 32).

Pictures can be set as a background image of the following parts.

- Numerical Input, Numerical Display, Character Input, Message Display, Message
Switching Display, Calendar, Meter
» PictBridge protocol for USB printers is now supported. The USB printer can print screen
images and alarm log data.
» Brightness can be adjusted in 48 levels.

v v v Vv

Bugs Fixed
The following problems have been fixed: (HG3G)

» The screen title was missing when a Picture Display was placed at the top of a popup
screen.

» Picture Display reference devices would reset when they were outside the specified range.
» Meter needles were not displayed properly.

» Text would not display correctly when Windows fonts were used for the Y-axis label on a
Line Chart.

» Plotting would stop when the scroll function was used if the number of display points and
the scroll step size in a Line Chart were similar.

<Host I/F Driver>
Additional supported Drivers: (HG3G)

MODBUS/TCP Server

Koyo DirectLogic (Ethernet)

GE Fanuc Automation Series 90(SNP-X)
Keyence KV (Ethernet)

LS Industrial Systems MASTER-K
VIGOR VB/VH

YOKOGAWA FA-M3

JTEKT TOYOPUC

FUJI FREX-PC(CPU)

VvV VvV VvV VvV VvV VvV vV v v



4
4
4

FUJI FREX-PC(LINK)
FUJI MICREX-F
Toshiba PROSEC-T

Bugs Fixed

The following problems have been fixed:

4
4

Timer and counter settings could not be read correctly from IDEC FA3S.

Communication failed when the MICRO/I resetted while communicating with the CPU port
of a KEYENCE KV-1000 Series PLC.

The following issues would occur when a different communication speed was set for COM1
and COM2.

- SIEMENS S7-MPI Host I/F Driver :  COM2 could not communicate at 187500 bps.
- SIEMENS S7-200(PPI) Host I/F Driver :  COM2 could not communicate.

- Keyence KV700/1000 Host I/F Driver :  The communication speed set on COM2 would
not reflect correctly when communicating with the CPU port of a KEYENCE KV-1000
Series PLC.

- DM Link(1:1) Host I/F Driver :  COM2 could not perform event transmission.

- MELSEC-Q(CPU) Host I/F Driver :  The communication speed set on COM2 would not
reflect correctly.

<Application Software>

The following functions have been introduced.

4
4

New features / improvements are added from the Runtime System Software upgrade.

Pictures for the following parts have been added to the Part List and the part library.

- Numerical Input, Numerical Display, Character Input, Message Display, Message
Switching Display, Calendar, Meter

The option to show or hide script errors.

It is now possible to set scripts to run at set intervals (Cyclic Script) without affecting
screen scan time (on-screen part processing). This is an effective function when using
expansion units.

Bugs Fixed

The following problems have been fixed:

»

If "DPI setting" was set to anything other than "Normal size" under "Display Properties" in
Windows, then WindOI-NV2 would crash after a new project was created or opened.
Unusable options would display for the “Serial Interface” of the host communication
protocol depending on the host I/F driver.

When opening a project created in an old version and converting data to the new version,
all host device settings used in the project would reset if the new project name contained
two or more spaces or a "." (period).

If a script was set for a multi-button or a multi-command and the host device set in the
script would not set for any other parts on the same screen, then the device value could
not be read correctly by the MICRO/I.



» When setting a data log, a message saying that the data storage area was insufficient
would be displayed even if there actually was sufficient free space.

<Downloader>
The following functions have been introduced.
» The HG3G series is now supported.

<Pass-Through Tool>
The following functions have been introduced.
» Now supports pass-through between the USB port of HG3G and a MELSEC FX Series PLC.

<Manual>

Communication Manual
Removed discontinued IDEC PLCs which are FA-3S, FA-2], MICRO3 and MICRO3C.



WindO/I-NV2 Ver.4.24

<Runtime System Software>
Bugs Fixed
The following problems have been fixed:

» Modified the touch panel driver to fix that the HG1F touch panels didn't always respond.
» Fixed that the settings of MAC Address and LCD size were reset on HG3G if the power was
turned off right after the power was applied or the screen was changed to System menu.



WindO/I-NV2 Ver.4.23

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» HG3G might not be powered up. The possibility of this problem depends on each individual
unit.

<Host I/F Driver>
The following functions have been introduced.

» Improve DM Link(1:1) or DM Link(1:N) host I/F driver to reduce the influence of scan
speed from the driver when large amount of communication happens.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» You change the O/I type or the Host I/F driver of the project which contains the scripts
written by using tags. When you download this project without editing the scripts, the
scripts do not work properly.

» When you use the Monitor function on Windows 7 (32-bit/64-bit), WindO/I-NV2 crashes
under the following conditions.

1) In the Properties dialog box of the Word Button, Key Button, Selector Switch, Pilot
Lamp, Character Input or Picture Display, "While satisfying the condition" is selected as
Trigger Type on the Trigger Condition tab and tags are used in the Condition.
2) In the Object List window, there is the part object which "While satisfying the
condition" is selected as Trigger Type on the Trigger Condition tab next to the above part
object 1).

» If you download an unusual project to the HG2G or the HG3G, the communications
problem arises between the WindO/I-NV2 and the HGs.

» After you setup the Pilot Lamp on the editing screen, the Recover Background check box is
always masked when you reopen the Properties dialog box of it.



WindO/I-NV2 Ver.4.22

<Application Software>

Bugs Fixed
The following problems have been fixed:

» With Ver.4.21, unknown error occurs and WindO/I-NV2 freezes when trying to convert from
the HG*F/HG2S project data to HG3G's.

» When the O/I type is "HG3G" and the “With Unit” checkbox of Numerical Input or
Numerical Display is selected, "1" is always set to the Magnification settings.

» If the “Fixed Period” is selected as the Switching Method of the Picture Display and the

Interval is set to the specific value, HG3G keeps resetting itself when the screen contains
this Picture Display is displayed.



WindO/I-NV2 Ver.4.21

<Application Software>

Bugs Fixed
The following problems have been fixed:

» After uploading a project which included 24-bit bitmap from HG3G, the bitmap files were
corrupted.

» The magnification settings of Numerical Display and Calendar did not change if the O/I
type was "HG3G" and the font type was "Standard".

» The display value on Numerical Input was garbled if the O/I type was "HG3G" and the font
size was "16x16".



WindO/I-NV2 Ver.4.20

<Runtime System Software>
The following functions have been introduced.

» The HG3G series is now supported.
» The following functions have been added to HG3G series.
- Ability to play sound files.
- Ability to display bitmap and JPEG files.
- Ability to display scalable fonts.
- Internal devices for digital input/output (LEX, LEY, WLEX, and WLEY).
- Ability to change transparency of popup screens.
- The File Copy function.
- The Project Transfer function.
- The PLC Program Transfer function.
- Ability to support external memory devices (USB flash drives and SD Memory Cards)
- AutoRun function for USB flash drives.

- Afunction that allows pictures displayed in the Picture Display to be switched at regular
intervals.

- Ability to connect USB barcode readers.

- Ability to set the names of files stored in SD Memory Card when using the Alarm Log,
Data Log, Operation Log, and Recipe functions.

- An automatic dimmer function.

- The HG Special Internal Register (LSD31), capable of saving screen numbers.
» The HG2G Series now supports:

- The HG Special Internal Register (LSD31), capable of saving screen numbers.

<Host I/F Driver>
The following functions have been introduced.
» The Modbus ASCII Communication Driver has been added.

<Application Software>
The following functions have been introduced.
» Items concerning models, functions, and settings in conjunction with the runtime system
software for HG3G series improvements.
» Logical AND (&&) and Logical OR (]|) as logical operators for part trigger conditions.
» The picture data for HG3G.
» Tag Editor now supports Allen-Bradley device addresses.



<Manuals>

Communication Manual
The following connection diagrams have been revised:

» Allen-Bradley: Connection Diagram 4(HG2G/3G Terminal)
» YASKAWA: Connection Diagram 3(All models)
» DM Link Communication: Connection Diagram 3.1.1(HG2G/3G Terminal, HG2F/3F/4F)



WindO/I-NV2 Ver.4.14

<Application Software>

Bugs Fixed
The following problems have been fixed:

» The program would sometimes crash when the user edited a new project or an existing
project saved in the folder set as the default path and then attempted to save the project
under a different name in the same folder.

» When "Data Type" is set as "float32" for a Numerical Inputnumerical display or numerical

input partNumerical Display, the "Minimum" and "Maximum" values for the Data Over
range would revert to "0" even if they were set to values other than "0".



WindO/I-NV2 Ver.4.12

<Runtime System Software>

Bugs Fixed
The following problems have been fixed:

» Watch Dog function does not work in HG2G/HG1F/HG2F/HG2S/HG3F/HGA4F series after the
MICRO/I recovers from Host Communication Error

<Host I/F Driver>
The following functions have been introduced.

» The Ethernet Communication Driver for Omron PLCs has been added in HG2G/HG3F/HG4F
series.

<Application Software>

Bugs Fixed
The following problems have been fixed:

» The Forbid Web Server function checkbox on Project Settings dialog box > Communication
Interface tab is always disabled (not selectable) when O/I Type is HG3F or HG4F series.

<Manual>

Communication Manual

The Expansion Communication Module, RS485 (part number FC5A-SIF4) has been added in
the Communication Manual.

Pass-Through Tool Manual
Capter.4 Operations: [Note] has been updated.



WindO/I-NV2 Ver.4.11

<Runtime System Software>
The following functions have been introduced.

» The maximum number of screen capture can be set by entering a value in the HG Special
Register (LSD65). This is only applicable to HG3F/HG4F Series.

<Host I/F Driver>
The following functions have been introduced.

» HG1F/HG2F/HG2G/HG2S/HG3F/HG4F support VIGOR VB/VH Series PLC.
» The stability and reliability of the communication are improved in SIEMENS S7 MPI driver.

<Application Software>
The following functions have been introduced.

» “Replace for Device Address” is supported when Connection Type is “1:N Communication”,

» Preference settings of Tag Editor are moved from WindO/I-NV2 Options dialog box to
Context menu of Tag Editor.

<Manual>

Instruction Manual

Add notice about the write number of times in Flash Memory by using HG Special Relay
(LSM10).



WindO/I-NV2 Ver.4.10

<Runtime System Software>
The following functions have been introduced.

» HG2G DC12V model is now supported.
» HG2G Pass-through function via Ethernet is now supported.

» The touch panel determination handling has been improved to avoid the unexpected
behavior which caused by pressing two points at the same time. When pressing two points
at the same time, the second one will not be accepted.

Bugs Fixed
The following problems have been fixed:

» O/I Link Communication do not work when SERIAL I/F 1 is set as O/I Link Slave, and
SIEMENS 'S7 MPI’ or 'S7-200(PPI)" is selected as Host I/F Driver in HG2G series.

<Host I/F Driver>

The following functions have been introduced.

» The communication driver has been added for Toshiba EX100 to HG1F, HG2F, HG2G, HG2S,
HG3F and HGA4F series.

Bugs Fixed
The following problems have been fixed:

» The Event Output might not work if DM Link (1:1) or DM Link (1:N) with HG2G Series is
selected.

<Application Software>
The following functions have been introduced.

» Able to open the Tag Editor from WindO/I-NV2 when launched from WindCFG.

» Able to change the display order and hide the Tag Name column to Options dialog box of
WindO/I-NV?2.

» The customize feature of Quick Access Toolbar has been improved.

» You can open the Tag Editor from Device Address Settings dialog box and check the Device
Address usage.

» The “Replace” Device Address feature is supported and it is found at the Editing group on
the Home tab.

» The icon displayed on the Editing Window tab has been modified to conform to the icon for
Base Screen and Popup Screen displayed on Ribbon Control and Project Window.

» The operation of a zoom slider on the Status Bar has been improved.



The short cut menu of Tag Editor is added on the Project Window.

The following icons are modified on the Project Window: Text Manager, Picture Manager
and Script Manager.

Editing the Focus Order for Numerical Input and Character Input without changing the
Screen Properties is now available.

Bugs Fixed

The following problems have been fixed:

»

After changing the Host I/F Driver, the Error Check has failed to check for device addresses
used in the screen data.

The CSV file can not be imported with Tex Manager if it includes the string with over 500
bytes in size.

After opening the project and Auto Hide function is enabled, the Project Window, Screen
List, Object List, Part List and Toolbox are displayed.

Even though the project is saved, the information on the Screen List window is not
updated.

After starting drawing by double-clicking the drawing object on the toolbox, you can not
keep drawing if you delete object with Delete key.

Multiple users can easily edit one project at the same time.

The items you select for the Workspace (under Setup > Object List tab) are showing
differently on the Object List window.

The project file name is kept in the Recent Project list even if you never saved it.

If you change the font setting for multiple buttons by using the common properties dialog
box, it will not apply properly.

The display text on the imported screens are not correct even if you have changed the Text
ID numbers when you import the screens which use the same ID numbers in the editing
project.

<Pass-through Tool>

Ethernet Pass-Through feature

The following functions have been introduced.

Pass-Through via Ethernet between the MICRO/I and the PLC Programming Software is now
available.

<Manual>

Instruction Manual

Chapter 26 Pass-Through Function: Updated the contents of HG2G series supporting Ethernet
Pass-Through.



WindO/I-NV2 Ver.4.01

<Runtime System Software>

1. Project Data size

Incresed the downloadable project data size for HG1F and HG2F to the same size as Ver.2.3 of
runtime (WindO/I-NV2 Ver.3.3).

<Application Software>

1. Change O/l Type

Fixed that WindO/I-NV2 showed the error message and froze when you tried to change the O/I
type after exporting the project from WindCFG.

2. Open Project

Fixed that WindO/I-NV2 crashed if you tried to open the project made with the earlier version
and clicked Cancel button on the Save As dialog box after converting it.

3. Line

Fixed that the setting value did not affect to the display image on the editing window correctly
if you changed the value by clicking the up-arrow or down-arrow button of the coordinates or
the size spin box on Format tab.

4. Text

Fixed that the display image in the editing window differed from the MICRO/I when ‘Shadow’
was selected as Style in the Properties dialog box.

5. Parts List
Fixed that Parts List was not available when the O/I type was HG4F.

6. Screen List and Parts List

Fixed that nothing was shown in the list after reopening your project after you closed it with
the Screen List and the Parts List in auto-hide.

7. Color Palette

Fixed that the Color Palette would change from the 256-colors (considering 256 color was the
original) to the monochrome or vice versa where monochrome is considered as the original
after executing the Target Info.

8. Batch Monitor

Fixed that WindO/I-NV2 might crash when you tried to close the Batch Monitor after selecting
‘Host’ as Target.



<Downloader>

1. Read Device Data, Write Device Data
Increased “No. of Data” from 64 to 2000.

2. Upload Log Data

Fixed the problem that the uploading of Logging Data with using command line failed in
HG1F/2F/2S/3F/4F.



WindO/I-NV2 Ver.4.00

[New feature/Improvement]
The following functions are introduced to WindO/I-NV2 Version 4.00.
<Host I/F Driver>

1. Modbus RTU

Supported the setting to use No.0 as Broadcast No.

2. OpenNet(FC3A), MicroSmart(FC4A/FC5A), Web Server
Unit(FC3A/FC4A/FC5A)

Supported AutomationOrganizer.

» United SM to M and united SD to D.
» Changed the name of TN to TC and CN to CC.
» Changed the name of Device number to Network Number.

<Application Software>

1. Changed New GUI (Graphics User Interface)

Pull-down menu and Tool bars were changed to Ribbon Control and allows you to access
frequently used commands with minimum steps.

oY) - I s Sample.n2g - WindO /- N2

Configuration Online View Format

a0 X = open - bl G| q? T A ‘ E ( 0 m n _ﬁ . = A autoResize ‘ = "] Upload ~
j =3 Copy | ' [ Delete \—}M‘ | N é g0 = i Targetinfo
Paste Mew Shapes Picture Text Buttons Lamps Displays Charts Commands || Select Arrange Download
%Duplicate | v %Reuse - | - - - ~ - ~ - “§f4 Comm, Setup

2. Advanced Interactivity for WindCFG and WindLDR

WindCFG (New System Configuration Software) provides the advanced interactivity between
WindO/I-NV2 and WindLDR. Those two softwares can share the PLC device address
information such as tag name and comments each other automatically.

3. Expanded Device address capabilities

» Tag name is now available.

» Added the cross reference function.

» Device Addresses are set by drag & drop operation using WindCFG and Tag Editor
»

Expanded the device address format. It allows the same as WindLDR. The previous
WindO/I-NV2 format is still available.

(The expanded format allows "." as the separator of bit instead of "-", and the space between
Device Type and Address will not be necessary.)



<Manual>

1. Instruction Manual
Modified the Manual No. of Instruction manual to HG9Y-B1118.

[Fixed Problems]
<Runtime System Software>

1. HG2G Host I/F Driver S7-MPI

Fixed that in the software Ver.3.41 or Ver.3.42, "Host Communication Error" would be shown if
using S7-MPI driver.

2. HG2G Screen

Fixed the MICRO/I reset problem. The MICRO/I reset if the following conditions were met.

I) A non-existing base screen is set as an overlay screen for a base screen.
2) Selects the "Display Order of Overlapping Screen" to a non-existing overlay screen number.
3) The program is downloaded to the MICRO/I

4) When the screen is switched to a base screen that is set as a non-existing overlay screen in
Monitor Mode, the MICRO/I is reset.

<Host I/F Driver>

1. HG2G OMRON SYSMAC-C

Fixed the following bugs.

»  Bits are not kept in a byte when the bit write is executed.

» The value of one device read from PLC first is not updated.

2. HG1F/2F/2S/3F/4F OpenNet(FC3A), MicroSmart(FC4A/FC5A), Web Server
Unit(FC3A/FC4A/FC5A)

"Host Communication Error" would be shown if the project data contained the following
condition when using HG1F/2F/2S/3F/4F.

» Reading more than 20 consecutive addresses and the device would be the Timer
Contact(T) or Counter Contact(C)

<Application Software>

1. Numerical Input, Character Input

When Keypad Type is Current Screen and Always Entry Mode check box is ON, Reverse check
box is masked.



<Manual>

1. Communication Manual

» Modified the connection diagram 2 and 4 of HG2G in Mitsubishi.

» Modified the connector type of connection diagram 1 in Allen-Bradley.
» Modified the connector type of connection diagram 7 in Allen-Bradley.
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